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1. The basic architecture of computer was developed by 

A) John Von Neumann  

B) Charles Babbage  

C) Blaise Pascal  

D) Garden Moore  

         

2. Can you tell what passes into and out from the computer via its ports? 

A) Data 

B) Bytes 

C) Graphics 

D) Picture  

         

3. Which of the items below are considered removable storage media? 

A) Removable hard disk cartridges 

B) (Magneto-optical) disk 

C) Flexible disks cartridges 

D) All of the above 

          

4. Which of the following is not purely output device? 

A) Screen 

B) Printer 

C) Speaker 

D) Plotter          

5. In how many generations a computer can be classified? 

A) 6  

B) 3 

C) 4 

D) 5          

6. The brain of any computer system is  

A) ALU  

B) Memory  

C) CPU  

D) Control unit           

7. What difference does the 5th generation computer have from other generation 

computers?  

A) Technological advancement  

B) Scientific code  

C) Object Oriented Programming  

D) All of the above          

8. __________ is the signals or data received by the system. 

A) Input  

B) Error  

C) Exception  

D) Output 
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9. Signals or data sent from system is called as ______________. 

A) Input  

B) Variable 

C) Exception  

D) Output  

          

10. The first Macintosh computer was from 

A) First generation 

B) Second generation 

C) Third generation 

D) Fourth generation 

          

11. Which is not a computer classification? 

A) mainframe 

B) max frame 

C) mini 

D) notebook 

          

12.  Which operation is not performed by computer 

A) Inputting 

B) Processing 

C) Controlling 

D) Understanding 

          

13. A collection of related instructions organized for a common purpose is referred to as 

A) File 

B) Database 

C) Program 

D) None of above 

        

14. Which language is directly understood by the computer without translation program? 

A) Machine language 

B) Assembly language 

C) High level language 

D) None of above 

          

15. On which aspect the analog computers are better than digital? 

A) Speed 

B) Accuracy 

C) Reliability 

D) Automatic 
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16. Which of the following terms is the most closely related to main memory? 

A) Non volatile 

B) Permanent 

C) Control unit 

D) Temporary 

          

17. The word length of a computer is measured in 

A) Bytes 

B) Millimetres 

C) Meters 

D) Bits 

           

18. Which unit holds data permanently? 

A) Input unit 

B) Secondary storage unit 

C) Output Unit 

D) Primary Memory Unit 

          

19. Computer system comprises of major units 

A) input unit, output unit, control unit 

B) input unit, output unit, control unit and storage 

C) input unit, output unit, central processing unit and storage unit 

D) input, output and storage units 

          

20. Signals can be analog or digital and a computer that processes the both type of signals is 

known as 

A) Analog computer 

B) Digital Computer 

C) Hybrid Computer 

D) Mainframe Computer 

          

21. Which company is the biggest player in the microprocessor industry? 

A) Motorola 

B) IBM 

C) Intel 

D) AMD 

          

22. Which of the following is a storage device? 

A) Tape 

B) Hard Disk 

C) Floppy Disk 

D) All of the above 
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23. Central Processing Unit is combination of 

A) Control and storage 

B) Control and output unit 

C) Arithmetic logic and input unit 

D) Arithmetic logic and control unit 

          

 

24. CD-ROM stands for 

A) Compactable Read Only Memory 

B) Compact Data Read Only Memory 

C) Compactable Disk Read Only Memory 

D) Compact Disk Read Only Memory 

          

25. What type of device is computer keyboard? 

A) Memory 

B) Output 

C) Storage 

D) Input 

          

26. Fifth generation computer is also known as 

A) Knowledge information processing system 

B) Very large scale integration (VLSI) 

C) Both of above 

D) None of above 

          

27. ALU is 

A. Arithmetic Logic Unit 

B. Array Logic Unit 

C. Application Logic Unit 

D. None of above 

          

28. WAN stands for 

A. Wap Area Network 

B. Wide Area Network 

C. Wide Array Net 

D. Wireless Area Network 

          

29. Second Generation computers were developed during 

A. 1949 to 1955 

B. 1956 to 1965 

C. 1965 to 1970 

D. 1970 to 1990 
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30. The computer size was very large in  

A. First Generation 

B. Second Generation 

C. Third Generation 

D. Fourth Generation 

          

31. Microprocessors as switching devices are for which generation computers 

A. First Generation 

B. Second Generation 

C. Third Generation 

D. Fourth Generation 

           

32. Which generation of computer is still under development 

A. Fourth Generation 

B. Fifth Generation 

C. Sixth Generation 

D. Seventh Generation 

          

33. Which statement is valid? 

A. 1KB = 1024 bytes 

B. 1 MB=2048 bytes 

C. 1 MB = 1000 kilobytes 

D. 1 KB = 1000 bytes 

          

34. Software in computer 

A. Enhances the capabilities of the hardware machine 

B. Increase the speed of central processing unit 

C. Both of above 

D. None of above 

          

35. Which of the following is a secondary memory device? 

A. Keyboard 

B. Disk 

C. ALU 

D. All of the above 

 

          

36. The differeŶĐe ďetǁeeŶ ŵeŵory aŶd storage is that ŵeŵory is … aŶd storage is … 

A. Temporary, permanent 

B. Permanent, temporary 

C. Slow, fast 

D. All of above 
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37. Which will not  harm  computer resources    

A. firewall  

B. Virus  

C. Trojan horse  

D. None of the above 

          

38. The first Generation computer was based on which technology? 

A) Transistor  

B)  LSI  

C)  VLSI  

D)  Vaccum Tube 

 

39. Who protects system from external threats?  

A) firewall  

B) EDI  

C) ERP  

D) Script kiddies 

 

40. Microsoft Word is an example of  

A. an operating system  

B. Processing device 

C. Application software 

D. an input device 

 

41. Which of the following is not a text editor 

  A)Notepad                 B)  Textpad 

C)Textmate     D)  MS Excel 

 

42. The key board shortcut for making fonts Italic is    

A) Ctrl + C     B)  Ctrl + I 

C)  Ctrl + X      D)  Alt + B 

43.  The short cut for centrally aligning a text  is   

      A) Ctrl+C     B) Ctrl+L 

      C) Ctrl+E     D) Ctrl+R 

 

44.  Replacing a word with another word throughout the document can be done 

using 

              A) Cut and Paste     B) Find and Replace 

              C) Copy and Paste     D) Go 

 

45. Which among the following is not an option in editing group? 

A) Find                     B)   Replace 

        C)     Select                   D)   Illustrations 
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46. The short cut for centrally aligning a text is   

 a.  Ctrl+C      b. Ctrl+L 

 c. Ctrl+E      d. Ctrl+R 

 

47.  Which of the key shortcut is used for printing a document in word ? 

         a. Ctrl+P      b. Ctrl+R 

         c. Altl+P      d. Alt+R 

 

48.  The keyboard short cut for cut command  is   

         a. Ctrl+C      b. Altl+C 

         c. Ctrl+X      d. Alt+V 

 

49.  The key board shortcut for making fonts bold is    

a)  Ctrl + C      b)  Ctrl + B 

c)  Ctrl + X       d)  Alt + B 

 

50.  Which of the following is not a type of page margin? 

 a) Normal     b) Narrow 

c)  Moderate      d) Middle 

 

51. Portrait and Landscape are  

 a) Paper Size     b) Page layout 

 c)  Page orientation     d) None of the above  

 

52.  Which of the following is not a font style? 

 a) Bold      b) Superscript 

 c)  Regular      d) Italics 

53.  Which enables us to send the same letter to different persons? 

 a) Macros     b) Mail merge 

c)  Template      d) None 

 

54. Which of the following is not an essential component to create mail merge? 

 a) Main document    b) Data source 

 c) Merge fields      d) Word fields 

 

55. ________consists of most frequently used commands such as cut, copy, paste, print etc 

 a) Quick access toolbar    b) Title bar 

 c)  Status bar      d) Rulers 

 

56. Number of tabs in MS word 

  a) 8      b) 7 

 c)  10       d) 5 
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57. Which of the following is not an option under font group? 

a) Underline   b) Bold 

c)  Shapes    d) change case 

 

58. The word indicates the spelling errors with 

a) Blue Underline   b) Green Underline 

 c) Red Underline    d) Black Underline 

 

59. The word indicates the grammar mistakes with 

a) Blue Underline   b) Green Underline 

  c) Red Underline    d) Black Underline 

 

60. The keyboard short cut for Undo command is   

            a. Alt+U     b. Ctrl+Y 

            c. Ctrl+U     d. Ctrl+Z 

 

61. The keyboard short cut for Redo command is   

            a. Ctrl+R     b. Ctrl+Y 

            c. Ctrl+J     d. Alt+R 

 

62. The keyboard short cut for Paste command is   

            a. Ctrl+V     b. Ctrl+P 

            c. Ctrl+J     d. Alt+P 

 

63. The keyboard short cut for justifying alignment is   

            a. Ctrl+A     b. Ctrl+Y 

            c. Ctrl+J     d. Ctrl+N 

 

64. The keyboard short cut for creating a new document is   

            a. Alt+N     b. Ctrl+N 

            c. Alt+D     d. Ctrl+D 

 

ϲϱ. The keyďoard short Đut for ͚Saǀe͛ ĐoŵŵaŶd is   
            a. Ctrl+S     b. Ctrl+P 

            c. Ctrl+V     d. Alt+S 

66._______is a collection of predefined design elements and colour schemes 

 a. Feature     b. Hyperlink 

            c. palette     d. theme 

   

67. Change the _____to create a document in wide format 

 a. Page Margins     b. Paper Style 

            c. Page Orientation     d. Paper Source 
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68______consists of information about the active document like number of words, lines, active 

page number etĐ… 

          a. Menu Bar     b. Status Bar 

          c. Scroll Bar     d. Title Bar 

 

69. Which operation you will perform if you need to move a block of text. 

          a. Copy and paste     b. Paste and delete 

          c. Cut and paste     d. Title Bar 

 

70. To view header and footer you must switch to  

 a. Normal View     b. Print layout view 

 c. Print Preview mode     d. Both B and C 

  

71. From where you can access save command. 

 a. Home tab      b. Insert tab 

 c. Review tab      d. None of above 

   

ϳϮ. WhiĐh of the folloǁiŶg is Ŷot oŶe of the three ďasiĐ tasks of ͚Mail Merge?͛ 
 a. Create main document    b. create data source 

 c. Merge two files     d. Set the mailing list    

                                                                                                 parameters 

  

73. Essential business letter elements include the_________ 

 a. Date line and inside address   b. Message 

 c. signature bloc     d. all of above  

    

74. Which of the following helps to reduce spelling error in the document? 

 a. Auto Format     b. Auto Correct 

 c. Smart tags      d. Auto text. 

   

75. In Word 2007 the Zoom is placed on  

 a. View tab      b. Home tab 

 c. Status bar      d. both A & C  

   

76. A command under a group is known as _____ 

 a. Button      b. tab 

 c. Ribbon      d. None of above  

   

77.________indicates writable area of the document 

 a. Gridlines      b. Rulers 

 c. Thumbnails      d. Document map   

78.  Which is not an option to insert equations? 

 a. Equations      b. Symbols 

 c. SmartArt      d. MS Equation Editor 
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79. What is the default file extension for all word documents?  

 a. .txts       b.  . word 

 c.  .docs      d.  .docx 

  

80. What is the smallest and largest font size tool on formatting toolbar?  

 a. 8 and 72      b. 8 and 64 

 c. 12 and 72      d. none of the above. 

 

81. The extension of database file in excel is  

 a. .doc       b. .xls 

 c. bmp       d. dbf  

82. The menu for locating regression in MS Excel is  

 a. Format      b. Tools 

 c. Insert      d. Data Analysis 

 

83.  Which of the following formula in excel is used for exponential operation? 

 a. ^       b. + 

 c. *       d. / 

  

84. Analysis toolpak is an add-in function in  

 a. PowerPoint      b. Excel 

 c. Word      d. Access 

85. Which of the following is an electronic spreadsheet? 

 a. PowerPoint      b. Excel 

 c. Word      d. Access 

86. Solver is an add-in function in  

a. PowerPoint      b. Word 

c. Excel       d. Access 

  

87. Conditional sum wizard  is an add-in function in  

a. PowerPoint      b. Word 

c. Excel       d. Access 

 

88. Which of the following is an operator for defining natural logarithm in excel worksheet 

a. =Ni().      b. =Ln() 

c. =^()       d. =log() 

89. Which of the following defines a formula in excel ? 

 a. &.       b. * 

 c. ^       d. = 

  

90. Which among the following is a valid cell address in MS Excel? 

a. A:20       b.   B;15 

c.  D6       d.  10H 



SCHOOL OF DISTANCE EDUCATION 
 

COMPUTER APPLICATION FOR ECONOMIC ANALYSIS  Page 12 

 

  

91. Which among the following represents a union type cell reference in Excel? 

a.  (A10:A20)     b.   (B10:B20) 

 c.   (A10,A20)     d.   A10 

  

92. Which among the following represents a range type cell reference in Excel? 

a.  (A10:A20)     b.  (B10,B20) 

b.  (A10,A20)     d.   A10 

  

93. Which among the following represents a individual cell reference in Excel? 

a. (C10:C20)     b.   (D10,D20) 

 c.    (A10,A20)     d.  F10 

  

94. ________useful to display trend of an economic variable over a time period 

 

  a. Line chart     b. Bar chart 

  c. Pie Chart     d. Scatter plot 

 

95. AutoSum can be used to calculate 

  a. Sum       b. Average 

  c. maximum     d. All of the above 

  

96.  Which of the following is not an element in formula syntax? 

  a. equal to sign    b. operator 

  c. chart     d. cell address 

  

97. Which of the following is forecasting tool? 

  a. Moving Average    b. Variance 

  c. Linear trend line    d.Cubic trend line 

  

98. The function library is available under _______tab. 

  a. Formula     b. Insert 

  c. data       d. Review 

 

        

99. __________ means the structure or order of the elements of a formula 

a. Operator     b. cell  

c. Formula Syntax     d. Operand 

 

100. Which of the following methods cannot be used to enter data in a cell? 

   a. Pressing an arrow key   b. pressing an tab key 

   c. Pressing escape key    d. clicking on the formula bar 
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101.  You can activate a cell by  

a. Pressing tab key     b. clicking the cell 

c. Pressing an arrow key   d. All of above 

  

102.  Which of the following is not a basic step in creating a worksheet?  

 a. Save workbook    b. modify the worksheet 

 c. Enter text and the data   d. copy the worksheet 

   

103. How many worksheets a workbook normally consist of? 

 a. 3      b. 2 

 c. 1      d. 4 

   

104. Which area in an excel allows entering values and formulas  

a. Title bar 

b. Menu bar 

c. Formula bar 

d. Standard toolbar 

  

105.  ________cell address remains constant, no matter where they are copied  

 a. Individual    b. Union  

 c. Range    d. Absolute. 

  

106. An excel workbook is a collection of  

 a. Workbooks    b. Worksheets 

 c. Charts    d. None of above 

  

107. Excel Probably considers the cell entry January 1, 2000 to be a 

 a. Label     b. Value 

 c. Formula     d. Text String 

  

108.  You can enter which type of data into worksheet cells?  

 a. Labels, values, and formulas 

 b. Labels and values but not formulas 

 c. Values and formulas but not labels 

 d. Formulas only. 

  

109. If you want to show the sector wise contribution to GDP, which chart you will    prefer 

 a. Pie Chart    b. Line chart 

 c. Column chart   d. Area chart 

 

110.  If you want to show the sector wise contribution to GDP, which chart you will prefer 

 a. Pie Chart    b. Line chart 

 c. Column chart   d. Area chart 
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111. The operator to estimate variance is  

 a. =COVAR ()    b. =VAR () 

 c. =STDEV ()    d. =KURT () 

  

112. The operator to estimate mean is  

 a. =COVAR ()    b. = MODE () 

 c. =AVERAGE ()   d. =MEDIAN () 

  

113. The operator to estimate standard deviation is  

 a. =COVAR ()    b. =VAR () 

 c. = STDEV ()    d. =MEDIAN () 

  

114.  In Excel spread sheet, the currently active cell is indicated by  

 a. Cell Pointer    b. Formula bar  

 c. Toolbar    d. None of above 

  

115.  While estimating descriptive statistic using analysis toolpak, we need to check  

 a. Summary statistics  b. correlation 

 c. Anova   d. Covariance 

  

 

116.  Quadratic trend line is polynomial of order ___ 

 a. 1    b. 2 

 c. 3    d. 4 

  

117. Cubic trend line is polynomial of order ___ 

 a. 1    b. 2 

 c. 3    d. 4 

  

118. Which among the following is used as model selection criteria for trend lines? 

 a. Correlation coefficient   b. Constant 

 c. Slope     d. R
2 

  

119. Which among the following is not a descriptive statistics?  

 a. Mean    b. Regression 

 c. Median    d. Variance
 

 Answer: b 

120.  Which trend line you will choose if line plot is roughly a straight line? 

 a. Linear    b. Exponential 

 c. Cubic     d. Quadratic
 

  

121. Which tab provides the option to set chart and axis titles? 

 a. Insert    b. Layout 

 c. View     d. Design
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122. Which tab provides various styles of inserted chart? 

 a. Insert    b. Layout 

 c. View     d. Design
 

  

12ϯ. GettiŶg data froŵ a Đell loĐated iŶ a differeŶt sheet is Đalled….. 
 a. Accessing    b. Referencing 

 c. Updating    d. Functioning
 

  

124. Which of the following formula is not entered correctly? 

 a. =10+5    b. =5*9 

 c. 2+4     d. =10/2 

  

125.  ________is used to study the relationship between variables. 

 a. Pie Chart     b. Line chart 

 c. Column chart    d. Scatter Plot 

    

126. In line chart years are shown on  

 a. Vertical axis    b. Horizontal axis 

 c. Title     d. None of the above 

    

127.  _______ refers to displaying only the rows that meet certain conditions and the remaining 

rows are hidden 

 a. Filtering  b. Sorting 

 c. Numbering  d. Formatting 

    

128.  ______is used to display values in ascending or descending order. 

 a. Filtering  b. Sorting 

 c. Numbering  d. Formatting 

    

129. Formulas built-in into a spreadsheet are called _______ 

 a. Formulas   b. conditions  

 c. Functions   d. Labels 

   

130. The intersection of a raw and column is known as _____ 

 a. Cell   b. chart 

 c. Formula  d. Value 

   

131. Which of the following is a programme used to create presentations? 

 a. Word    b. Excel 

 c. PowerPoint    d. Access   

132. ______ helps to preview the slides in thumbnail form? 

 a. Title bar    b. status bar 

 c. Menu bar    d. Slide Sorter View 
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133. _________ are already created presentation on different topics. 

 a. Templates    b. Images 

 c. Video    d. Design 

   

134. The Background style of a power point presentation is known as  

 a. Animation    b. Theme 

 c. Transition     d. Effects 

   

135. The title slide consists of  

 a. Title Place holder     b. Subtitle Place holder 

 c. Both Title and subtitle Place holders  d. None o the above 

  

136. Which of the following is not an option to format the theme of the presentation?   

 a. Colours     b. Fonts 

 c. Effects     d. table 

  

137. Which of the following is not an option of transition?   

 a. Wipes     b. Push and cover 

 c. Random     d. Oriel 

  

138. Which key on the keyboard can be used to view the slide show? 

 a. F1      b. F2 

 c. F5      d. F10 

  

139. PowerPoint Presentation is a collection of ______ 

 a. Slides and Handouts   ď. Speaker͛s Notes 

 c. Outlines     d. All of the above 

  

140.  Which tab is not available on left panel when you open a presentation? 

 a. Outline     b. Slides 

 c. Notes     d. All of above 

  

141. The arrangement of elements such as title and subtitle text, pictures, tables etc. is called 

 a. Layout    b. Presentation 

 c. Design    d. Scheme 

    

142. Which of the following section does not exist in slide layout? 

a. Titles     b. Lists 

c. Charts     d. Animations    

142. After choosing a predefined template, which option has to be chosen to change the  

          background colour? 

 a. Design Template    b. Colour scheme 

 c. Animation Scheme    d. Colour Effects 
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143. Fly in is predefined _____________ 

 a. Design Template    b. Colour scheme 

 c. Animation Scheme    d. None of these 

  

144. Animation schemes can be applied to ___________in the presentation  

 a. All slides     b. Selected Slides 

 c. Current slide    d. All of the above 

  

145. To insert new slide in the presentation, we can choose 

 a. Ctrl+M     b. Ctrl+N 

 c. Ctrl+O     d. Ctrl+F 

   

146. In normal view, this tab displays the content of each slide 

 a. Slides     b. View 

 c. Sort      d. Outline 

  

147. Which is the menu to create text box on a slide 

 a. View->Text Box    b. Tools->Text Box 

 c. Insert->Text Box    d. Format->Text Box 

  

148.  A new presentation can be created from  

 a. Blank Presentation  b. From existing Presentation 

 c. From Design Template  d. All of above 

  

149. What PowerPoint feature will you use to apply motion effects to different   objects of a 

slide   

 a. Slide transition    b. Slide design 

 c. Animation Objects    d. Text Box 

  

150. What PowerPoint feature will you use to apply motion effects in between slide exits 

and another enters? 

 a. Slide transition    b. Slide design 

 c. Animation Objects    d. Text Box 

  

 

151. The selected design template can be applied to  

 a. To the current Slide only   b. To all the slides 

 c. To all the new presentations you create d. all of the above  

  

153. From which menu you can access picture, chart, smart card and movie 

 a. Home     b. Insert 

 c. Design      d. View 
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154. To insert a hyperlink in a slide  

  a. Insert>>Hyperlink     b. Ctrl+k 

  c. View>>Hyperlink      d. Both a & b 

    

155. Which of the following font effect is not available PowerPoint font dialog box? 

  a. Underline      b. Shadow 

  c. Emboss       d. Strikethrough 

    

156. The default Page set up orientation of slide in PowerPoint is  

  a. Vertical      b. Landscape 

  c. Portrait       d. None of above 

   

157. Objects on the slide that hold text are called  

  a. Placeholders     b. Object holders 

  c. Auto layouts      d. Text holders 

   

158. Which command brings you to the first slide in your presentation? 

  a. Next slide button     b. Page up 

  c. Ctrl+Home       d. Ctrl+End 

    

159. Which of the following can you use to add times to the slides in a presentation? 

  a. Slide show menu     b. Rehearse timings button  

  c. Slide transition button    d. All of the above 

     

160. Which of the following presentation elements can you modify using the slide 

master?  

  a. Slide comments     b. Slide transition 

  c. Speaker note font and colour   d. All of above   

  

161. Which of the following provides a printed copy of your presentation? 

  a. Outline     b. Speaker notes 

  b. Audience Handouts   c. All of the above 

 

162. What is internet? 

              a) a single network 

              b) a vast collection of different networks 

              c) interconnection of local area networks 

             d) none of the mentioned 

           

163. To join the internet, the computer has to be connected to a 

a) internet architecture board 

b) internet society 

c) internet service provider 

d) none of the mentioned 
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164. Internet access by transmitting digital data over the wires of a local telephone 

network is provided by 

a) leased line 

b) digital subscriber line 

c) digital signal line 

d) none of the mentioned 

           

165. Which one of the following protocol is not used in internet? 

                a) HTTP 

                b) DHCP 

                c) DNS 

                d) none of the mentioned 

           

166. Which of the following describes e‐commerce? 

a) Doing business electronically  

b) Doing business  

c) Sale of goods  

              d) All of the above 

 

 

           

167. Which protocol assigns IP address to the client connected in the internet? 

               a) DHCP 

               b) IP 

               c) RPC 

               d) none of the mentioned 

           

168. Bluetooth is an example of 

                a) personal area network 

                b) local area network 

                c) virtual private network 

                d) none of the mentioned 

 

           

169. Which products are people most likely to be more uncomfortable buying on the 

Internet?  

a) Books 

b) Furniture 

c) Movies  

d) All of the above 
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170. What are plastic cards the size of a credit card that contains an embedded chip  

              on which digital information can be stored? 

a) Customer relationship management systems cards  

b) E‐government identity cards 

c) FEDI cards  

d) Smart cards 

          

171. Which of the following are advantages normally associated with e‐commerce?  

a) Shorter cycle times  

b) Reduction in costs  

c) Reaches wider audiences  

d) all of the above 

           

172. Which of the following statements accurately reflect the impact of technology?  

a) Technology has caused buyer power to increase  

b) Technology has lessened the entry barriers for many industries  

c) Technology has increased the threat of substitute products and services  

d) all of the above 

           

173. How the transactions occur in e‐commerce?  

a) Using e‐medias  

b) Using computers only  

c) Using mobile phones only  

d) None of the above 

           

174. If you need to transfer money to another person via the internet, which of the            

              following methods could you use?  

a) financial cybermediary  

b) electronic check  

c) electronic bill presentment and payment  

d) all of the above  

 

            

175. E-business is a term used to describe  

a) Any electronically mediated communication between an organization and its  

              stakeholders  

b) The use of electronic communications for all business processes  

c) An organization using electronic media to purchase from to its suppliers  

d) An organization using electronic media to sell direct to its customers 

           

176. While there are obvious e-business advantages and opportunities, there are also          

              risks and barriers. These include 

a) Contravention of customer privacy  

b) Internet hackers penetrating company security  
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c) Spikes causing websites to fail at peak times  

d) All of the above 

          

177. Which of the following is not a method of accessing the web? 

a) ISDN 

b) CPU 

c) DSL 

d) Modem 

            

178. TCP stands for _______ 

a) Transport control protocol 

b) Transmission control protocol 

c) Terminal control protocol 

d) None of the given 

            

179. CRM stands for...............  

a) customer relationship management 

b) Customer Related Management 

c) Customer Resembling Management 

d) Customer Reallocation Management 

            

180. IP stands for _______ 

a) Internal protocol 

b) Interest protocol 

c) Internet protocol 

d) None of the given 

           

181. A network, which is used for sharing data, software and hardware among several  

        users of microcomputers, is called 

a) Wide Area Network. 

b) Metropolitan Area Network. 

c) Local Area Network 

d) Value Added Network.   

   

 

++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 
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Question Bank – Answer Key 

 

Quest. 

No 
Ans 

Quest. 

No 
Ans 

Quest

No 
Ans 

Quest

No 
Ans 

Quest

No 
Ans 

1 B 41 D 81 B 121 B 161 C 

2 A 42 B 82 D 122 D 162 B 

3 D 43 C 83 A 123 B 163 C 

4 D 44 B 84 B 124 C 164 B 

5 D 45 D 85 B 125 D 165 D 

6 C 46 C 86 C 126 B 166 D 

7 D 47 A 87 C 127 A 167 A 

8 A 48 C 88 B 128 B 168 A 

9 D 49 B 89 D 129 C 169 A 

10 A 50 D 90 C 130 A 170 D 

11 B 51 C 91 C 131 C 171 D 

12 D 52 B 92 A 132 D 172 D 

13 C 53 B 93 D 133 A 173 D 

14 B 54 D 94 A 134 B 174 D 

15 A 55 A 95 D 135 C 175 A 

16 A 56 B 96 C 136 D 176 A 

17 A 57 C 97 B 137 D 177 B 

18 B 58 C 98 A 138 C 178 B 

19 C 59 B 99 C 139 D 179 B 

20 C 60 D 100 C 140 C 180 C 

21 C 61 B 101 D 141 A 181 C 

22 D 62 A 102 D 142 D   

23 D 63 C 103 A 143 B   

24 C 64 B 104 C 144 C   

25 D 65 A 105 A 145 D   

26 A 66 D 106 B 146 B   

27 A 67 A 107 B 147 D   

28 B 68 B 108 A 148 C   

29 B 69 C 109 A 149 D   

30 A 70 D 110 A 150 C   

31 B 71 D 111 B 151 A   

32 B 72 D 112 C 152 D   

33 A 73 D 113 C 153 B   

34 C 74 B 114 A 154 D   

35 B 75 D 115 A 155 C   

36 A 76 A 116 B 156 B   

37 A 77 B 117 C 157 A   

38 D 78 C 118 D 158 C   

39 A 79 D 119 B 159 B   

40 C 80 A 120 A 160 B   

 


